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Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using the 

MCP8024 TQFP BLDC Motor Driver Evaluation Board. Items discussed in this chapter 

include:

� Document Layout

� Conventions Used in this Guide

� Recommended Reading

� The Microchip Web Site

� Customer Support

� Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP8024 TQFP BLDC Motor Driver Evalua-

tion Board. The manual layout is as follows:

� Chapter 1. �Product Overview� � Important information about the MCP8024 

TQFP BLDC Motor Driver Evaluation Board.

� Chapter 2. �Installation and Operation� � Includes instructions on how to get 

started with this user�s guide and a description of the user�s guide.

� Appendix A. �Schematic and Layouts� � Shows the schematic and layout 

diagrams for the MCP8024 TQFP BLDC Motor Driver Evaluation Board.

� Appendix B. �Bill of Materials (BOM)� � Lists the parts used to build the 

MCP8024 TQFP BLDC Motor Driver Evaluation Board.

� Appendix C. �Software� � Provides information about the application firmware 

and where the source code can be found.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 

documentation are constantly evolving to meet customer needs, so some actual dialogs 

and/or tool descriptions may differ from those in this document. Please refer to our web site 

(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a �DS� number. This number is located on the bottom of each 

page, in front of the page number. The numbering convention for the DS number is 

�DSXXXXXA�, where �XXXXX� is the document number and �A� is the revision level of the 

document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. 

Select the Help menu, and then Topics to open a list of available on-line help files.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User�s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 

dialog

�Save project before build�

Underlined, italic text with 

right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N�Rnnnn A number in verilog format, 

where N is the total number of 

digits, R is the radix and n is a 

digit.

4�b0010, 2�hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, �A�

Italic Courier New A variable argument file.o, where file can be 

any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 

[options]

Curly brackets and pipe 

character: { | }

Choice of mutually exclusive 

arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 

var_name...]

Represents code supplied by 

user

void main (void)

{ ...

}
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RECOMMENDED READING

This user's guide describes how to use MCP8024 TQFP BLDC Motor Driver Evaluation 

Board. Other useful documents are listed below. The following Microchip documents 

are available and recommended as supplemental reference resources.

� MCP8024 Data Sheet � �3-Phase Brushless DC (BLDC) Motor Gate Driver 

with Power Module� (DS20005228)

This data sheet provides detailed information regarding the MCP8024 product 

family.

� dsPIC33FJ32MC204 Data Sheet � �16-bit Digital Signal Controllers 

(up to 32 KB Flash and 2 KB SRAM) with Motor Control and Advanced 

Analog� (DS70283)

This data sheet provides detailed information regarding the dsPIC33FJ32MC204 

product family.

� dsPIC33FJ32MC204 Plug-In-Module � �dsPIC33FJ32MC204 PIM Information 

Sheet� (DS70316)

This data sheet provides detailed information regarding the dsPIC33FJ32MC204 

PIM.

� AN1078 Application Note � �Sensorless Field Oriented Control Of a PMSM� 

(DS01078).

� AN1160 Application Note � �Sensorless BLDC Control with Back-EMF 

Filtering Using a Majority Function� (DS01160).

� AN901 Application Note � �Using the dsPIC30F for Sensorless BLDC Con-

trol� (DS00901).

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 

site is used as a means to make files and information easily available to customers. 

Accessible by using your favorite Internet browser, the web site contains the following 

information:

� Product Support � Data sheets and errata, application notes and sample 

programs, design resources, user�s guides and hardware support documents, 

latest software releases and archived software

� General Technical Support � Frequently Asked Questions (FAQs), technical 

support requests, online discussion groups, Microchip consultant program 

member listing

� Business of Microchip � Product selector and ordering guides, latest Microchip 

press releases, listing of seminars and events, listings of Microchip sales offices, 

distributors and factory representatives

www.microchip.com
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DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip�s customer notification service helps keep customers current on Microchip 

products. Subscribers will receive e-mail notification whenever there are changes, 

updates, revisions or errata related to a specified product family or development tool of 

interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 

Change Notification and follow the registration instructions.

The Development Systems product group categories are:

� Compilers � The latest information on Microchip C compilers, assemblers, linkers 

and other language tools. These include all MPLAB C compilers; all MPLAB 

assemblers (including MPASM� assembler); all MPLAB linkers (including 

MPLINK� object linker); and all MPLAB librarians (including MPLIB� object 

librarian).

� Emulators � The latest information on Microchip in-circuit emulators.This 

includes the MPLAB REAL ICE� and MPLAB ICE 2000 in-circuit emulators.

� In-Circuit Debuggers � The latest information on the Microchip in-circuit 

debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit� 3 

debug express.

� MPLAB® IDE � The latest information on Microchip MPLAB IDE, the Windows® 

Integrated Development Environment for development systems tools. This list is 

focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 

MPLAB SIM simulator, as well as general editing and debugging features.

� Programmers � The latest information on Microchip programmers. These include 

production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 

ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 

are non-production development programmers such as PICSTART® Plus and 

PICkit 2 and 3.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

� Distributor or Representative

� Local Sales Office

� Field Application Engineer (FAE)

� Technical Support

Customers should contact their distributor, representative or field application engineer 

(FAE) for support. Local sales offices are also available to help customers. A listing of 

sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://www.microchip.com/sup-

port

DOCUMENT REVISION HISTORY

Revision A (December 2013)

� Initial Release of this Document.

http://www.microchip.com/support
www.microchip.com
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Chapter 1.  Product Overview

1.1 INTRODUCTION

The MCP8024 TQFP BLDC Motor Driver Evaluation Board is used to demonstrate the 

drive capabilities of the MCP8024. The board uses the MCP8024 3-Phase Brushless 

DC (BLDC) motor gate driver and dsPIC33FJ32MC204 Plug-In Module (PIM) to imple-

ment a 6-step trapezoidal BLDC motor controller.

The MCP8024 TQFP BLDC Motor Driver Evaluation Board is used to evaluate 

Microchip�s MCP8024 in a BLDC motor application. As provided, the MCP8024 TQFP 

BLDC Motor Driver Evaluation Board is ready to operate a BLDC motor using one 

on-board push button to start and stop the motor, plus one on-board potentiometer to 

set motor speed. The evaluation board can drive a BLDC motor with a supply voltage 

of up to 28V and a motor current up to 15A. The MCP8024 TQFP BLDC Motor Driver 

Evaluation Board provides a 6-step trapezoidal control algorithm along with a 750 mW 

buck converter, 5V and 12V LDO, high-to-low level voltage translators, current sense 

operational amplifiers and Hall-effect inputs. The evaluation board provides a status 

indication for the power supplies and the six on-board Pulse-Width Modulation (PWM) 

inputs.

This chapter covers the following topics.

� What is the MCP8024 TQFP BLDC Motor Driver Evaluation Board?

� What the MCP8024 TQFP BLDC Motor Driver Evaluation Board kit includes

FIGURE 1-1: MCP8024 TQFP BLDC Motor Driver Evaluation Board Block 

Diagram.
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1.2 WHAT IS THE MCP8024 TQFP BLDC MOTOR DRIVER EVALUATION 
BOARD?

The MCP8024 TQFP BLDC Motor Driver Evaluation Board is a complete stand-alone 

motor controller for brushless DC motors (BLDC). The board is capable of driving a 

three-phase brushless DC motor rated at up to 15A and 28V. The input voltage range 

for the board is 7V to 28V. The on-board MCP8024 generates 5V and 12V using inter-

nal voltage regulators. The MCP8024 also contains an internal buck regulator which 

generates the power for the attached dsPIC33FJ32MC204 host microcontroller. 

An input terminal block is provided to apply the input voltage to the board. An output 

header and plated Printed Circuit Board (PCB) through-hole pads are also provided as 

a means to connect the external motor. Two programming headers are available for 

updating the firmware contained in the dsPIC33FJ32MC204 using either a PICkit� 3 

programmer/debugger, MPLAB® REAL ICE� in-circuit emulator or an MPLAB ICD 3 

In-circuit debugger.

Two headers are also supplied on the board to allow users to create SPI and I2C� 

communication connections.

1.3 WHAT THE MCP8024 TQFP BLDC MOTOR DRIVER EVALUATION BOARD 
KIT INCLUDES

This MCP8024 TQFP BLDC Motor Driver Evaluation Board kit includes:

� MCP8024 TQFP BLDC Motor Driver Evaluation Board (ADM00557)

� dsPIC33FJ32MC204 Plug-In-Module (MA330017)

� Information Sheet
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Chapter 2.  Installation and Operation

2.1 INTRODUCTION

The MCP8024 TQFP BLDC Motor Driver Evaluation Board demonstrates Microchip�s 

3-Phase Brushless DC (BLDC) Motor Gate Driver with Power Module (MCP8024), 

used in a BLDC motor drive application. When used in conjunction with a 

microcontroller, the MCP8024 will provide the necessary drive signals to drive a 

3-Phase BLDC motor. The MCP8024 contains the high-side and low-side drivers for 

external N-channel MOSFETs. The dsPIC33FJ32MC204 Motor Control processor is 

used to supply the PWM inputs to the MCP8024, as well as handle the high-speed 

Analog-to-Digital Conversion (ADC) required for 40 kHz PWM operation.

The MCP8024�s UART interface is used to configure the device and to send fault 

information to the dsPIC® DSC controller. The evaluation board firmware, available on 

the Microchip website, uses a 6-step trapezoidal drive control algorithm to demonstrate 

the MCP8024 capabilities.

2.2 FEATURES

The MCP8024 TQFP BLDC Motor Driver Evaluation Board has the following features:

� Input Operating Voltage Range: +7.0V to +28V

� Maximum of 500 mA of gate drive current for external N-Channel MOSFETs

� Drives up to a 15A BLDC motor

� 750 mW Buck Regulator with resistor-programmable output voltage

� ON/OFF momentary contact switch

� Reset momentary contact switch

� Spare user-programmable momentary contact switch

� PWM signal LED indicators

� 100-pin dsPIC DSC PIM header for use with MA330017 compatible PIMs

� PICkit 3, MPLAB REAL ICE in-circuit emulator and MPLAB ICD 3 debugger 

interfaces

� Speed control potentiometer

� Terminal block for 5V and 12V Hall-effect sensors

� SPI and I2C headers for user communications

� Programmable external MOSFET overcurrent protection

� Programmable PWM dead-time protection

� Programmable PWM blanking time for current switching spikes

� Complete �C� source code (provided on the board web page)
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2.3 GETTING STARTED

The MCP8024 TQFP BLDC Motor Driver Evaluation Board is fully assembled and 

tested for driving a BLDC motor. This board requires the use of an external voltage 

source capable of supplying 7V to 28V at the rated motor current. A BLDC motor is also 

required to evaluate the motor driver. 

FIGURE 2-1: MCP8024 TQFP BLDC Motor Driver Evaluation Board Overlay.

2.3.1 Connections

2.3.1.1 JUMPER SETTINGS

The MCP8024 TQFP BLDC Motor Driver Evaluation Board has several 

user-configurable jumpers. The jumpers are described in Table 2-1.

TABLE 2-1: MCP8024 TQFP BLDC MOTOR DRIVER EVALUATION BOARD 

JUMPERS

Jumper Position Description

JP1 ON SPI Communications

JP2 1-2 Disable Buck Regulator

2-3 Enable Buck Regulator

JP3 1-2 I2C� Communications

2-3 SPI Communications

JP4 ON Enable dsPIC® DSC to DE2 Communications

JP5 ON Enable dsPIC DSC to DE2 Communications

JP6 1-2 Enable dsPIC DSC to PICkit� Serial Communications

3-4 Enable DE2 to PICkit Serial Communications
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2.3.1.1.1 The jumpers and their use are described in Table 2-2.

JP9 1-2 CE Pull Up

2-3 CE Pull Down

JP10 ON Routes DE2 to dsPIC DSC RP20/CN25/RC4 pin

JP11 1-2 Enable DE2 to PICkit Serial Communications

3-4 Enable dsPIC DSC to PICkit Serial Communications

JP12 (MONITOR1)

JP13 (MONITOR2)

JP14 (MONITOR3)

1-2 Connect Phase Current to MONITORn

3-4 Connect Filtered Phase Voltage to MONITORn

5-6 Connect Hall Sensor to MONITORn

JP15 1-2 5V Hall Sensor Power Supply

2-3 12V Hall Sensor Power Supply

JP16 � Sums Individual Phase Currents (soldered wire)

JP17 � Select Individual Phase Currents (soldered wire)

JP18 1-2 Current Sense Offset = 0.992V

2-3 Current Sense Offset = 0.0V

TABLE 2-1: MCP8024 TQFP BLDC MOTOR DRIVER EVALUATION BOARD 

JUMPERS (CONTINUED)

Jumper Position Description

TABLE 2-2: JUMPER DESCRIPTION

Jumper Position Description

JP1 (used with JP3) ON Enables PICkit� Serial SPI (J4) communications to the dsPIC® DSC

JP2 1-2 Disables the MCP8024 buck regulator by connecting the FB pin to +5V

2-3 Enables the MCP8024 buck regulator by connecting the FB pin to the buck out-

put voltage divider

JP3 (used with JP1) 1-2 Enables PICkit Serial I2C� (J4) communications to the dsPIC DSC

2-3 Enables PICkit Serial SPI (J4) communications to the dsPIC DSC

JP4 ON Enables the dsPIC DSC to Transmit to the MCP8024 DE2 pin

JP5 ON Enables the dsPIC DSC to Receive from the MCP8024 DE2 pin

JP6 1-2 Enables PICkit Serial UART (J1) Transmissions to the dsPIC DSC

3-4 Enables PICkit Serial UART (J1) Transmissions to the MCP8024 DE2 pin

JP7 Permanent jumper wire connecting Digital ground to Power ground

JP8 Permanent jumper wire connecting Analog ground to Power ground

JP9 1-2 Connects the MCP8024 CE pin to a pull-up resistor

2-3 Connects the MCP8024 CE pin to a pull-down resistor

JP10 ON Connects the dsPIC DSC RP20/CN25/RC4 pin to the MCP8024 DE2 pin

JP11 1-2 Enables PICkit Serial UART (J1) Reception from the MCP8024 DE2 pin

3-4 Enables PICkit Serial UART (J1) Reception from the dsPIC DSC

JP12 1-2 Connects the Phase A amplified motor current to the dsPIC DSC Monitor 1 

input

3-4 Connects the Phase A filtered motor current to the dsPIC DSC Monitor 1 input

5-6 Connects the Phase A Hall-effect sensor input to the dsPIC DSC Monitor 1 

input

JP13 1-2 Connects the Phase B amplified motor current to the dsPIC DSC Monitor 2 

input

3-4 Connects the Phase B filtered motor current to the dsPIC DSC Monitor 2 input

5-6 Connects the Phase B Hall-effect sensor input to the dsPIC DSC Monitor 2 

input
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The jumper settings for use with the sensorless trapezoidal drive firmware are 

described in Table 2-3.

2.3.1.2 POWERING THE MCP8024 TQFP BLDC MOTOR DRIVER EVALUATION 

BOARD (REFERENCE Figure 2-2)

1. Apply the input voltage to the input terminal block J5. The input voltage source 

should be limited to the 0V to +28V range. For nominal operation, the input 

voltage should be between +7.0V and +24V.

2. Connect the positive side of the input source (+) to pin 2 of J5. Connect the 

negative or return side (-) of the input source to pin 1 of J5. Refer to Figure 2-2.

JP14 1-2 Connects the Phase C amplified motor current to the dsPIC DSC Monitor 3 

input

3-4 Connects the Phase C filtered motor current to the dsPIC DSC Monitor 3 input

5-6 Connects the Phase C Hall-effect sensor input to the dsPIC DSC Monitor 3 

input

JP15 1-2 Sets the Hall effect supply to +5V

2-3 Sets the Hall effect supply to +12V

JP16 (used with JP17) Jumper wire connecting Phase B and Phase C sense resistors to Phase A 

sense resistor for summing phase currents

JP17 (used with JP16) Jumper wire connecting Phase B and Phase C sense resistors to ground for 

using individual phase currents

JP18 1-2 Sets the current sense amplifier offset voltage to 0.992 volts

2-3 Sets the current sense amplifier offset voltage to 0.0 volts

TABLE 2-2: JUMPER DESCRIPTION (CONTINUED)

Jumper Position Description

TABLE 2-3: JUMPERS USED BY SENSORLESS TRAPEZOIDAL FIRMWARE

Jumper Position Description

JP2 2-3 Enable Buck Regulator

JP4 ON Enable dsPIC® DSC to DE2 Communications

JP5 ON Enable dsPIC DSC to DE2 Communications

JP6 OFF Disable dsPIC DSC to PICkit� Serial Communications

OFF Disable DE2 to PICkit Serial Communications

JP9 2-3 CE Pull Down

JP10 OFF Disconnect DE2 to dsPIC DSC RP20/CN25/RC4 pin

JP11 OFF Disable DE2 to PICkit Serial Communications

OFF Disable dsPIC DSC to PICkit Serial Communications

JP12 (MONITOR1)

JP13 (MONITOR2)

JP14 (MONITOR3)

3-4 Connect Filtered Phase Voltage to MONITORn

JP16 OFF Deselect Summing Phase Currents

JP17 ON Select Individual Phase Currents

JP18 1-2 Current Sense Offset by 0.992V
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FIGURE 2-2: Connection and Operation Diagram.

2.3.1.3 CONNECTING A MOTOR MCP8024 TQFP BLDC MOTOR DRIVER 

EVALUATION BOARD

Connect each phase winding of the three-phase BLDC motor to the appropriate 

terminal of the motor terminal block (J6), terminals A,B,C. The neutral winding, 

terminal N, is not necessary for the sensorless trapezoidal drive firmware provided for 

the evaluation board.

2.3.2 Operating a Motor

1. Turn the Speed Adjust potentiometer (R75) fully counter-clockwise to obtain the 

slowest speed setting. Now turn the Speed Adjust approximately ¼ turn clock-

wise to allow for 25% motor speed.

2. Turn on the power supply connected to the board.

3. Press and release the RUN switch (SW2) to start the motor.

4. Turn the Speed Adjust potentiometer clockwise to increase motor speed, and 

counter-clockwise to decrease motor speed. The Speed Adjust changes the 

PWM duty cycle of the PWM signals that are being sent to the MCP8024.

5. Press and release the RUN switch again to stop the motor.

VDD

GND

J5

Input Power

J6

Motor 

Connections

PICkit� Header J2 Speed 

Adjust 

R75

RUN Switch 

SW2

RESET Switch

M1 

dsPIC® 

DSC PIM

J3 

ICD 3 

Header
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2.3.3 Indicator LEDs

The   MCP8024 TQFP BLDC Motor Driver Evaluation Board has ten LEDs to indicate 

system status. Table 2-4 lists the LED indicators and their descriptions.

2.3.4 Test Points

There are several test points on the board to allow probing of voltages, currents and 

signals.

TABLE 2-4: LED INDICATORS

PCB Location Name Description

D10 SPARE Spare LED on RA4 port

D11 +12V +12V LDO Voltage Operating

D12 +5V +5V LDO Voltage Operating

D13 +Buck Buck Output Voltage Operating

D14 PWM3H PWM Phase 3 high-side input to MCP8024

D15 PWM3L PWM Phase 3 low-side input to MCP8024

D16 PWM2H PWM Phase 2 high-side input to MCP8024

D17 PWM2L PWM Phase 2 low-side input to MCP8024

D18 PWM1H PWM Phase 1 high-side input to MCP8024

D19 PWM1L PWM Phase 1 low-side input to MCP8024

TABLE 2-5: TEST POINTS DESCRIPTION

Test Point Name Description

TP1 VDD Power Supply (+)

TP2 PGND Power Supply Ground (�)

TP3 DE2 MCP8024 DE2 Communications Signal

TP4 PGND Power Supply Ground (�)

TP5 PGND Power Supply Ground (�)

TP6 PGND Power Supply Ground (�)

PHA_FIL PHA_FIL Filtered Phase A Signal

PHB_FIL PHB_FIL Filtered Phase B Signal

PHC_FIL PHC_FIL Filtered Phase C Signal

NEU_FIL NEU_FIL Filtered Neutral Signal

MON1 MON1 Monitor Signal 1: Connects to A/D Channel 3

MON2 MON2 Monitor Signal 2: Connects to A/D Channel 4

MON3 MON3 Monitor Signal 3: Connects to A/D Channel 5

MON4 MON4 Monitor Signal 4: Connects to A/D Channel 6

D14 PWM3H PWM Phase C High-side Input to MCP8024

D15 PWM3L PWM Phase C Low-side Input to MCP8024

D16 PWM2H PWM Phase B High-side Input to MCP8024

D17 PWM2L PWM Phase B Low-side Input to MCP8024

D18 PWM1H PWM Phase A High-side Input to MCP8024

D19 PWM1L PWM Phase A Low-side Input to MCP8024

PAD42 POT Speed Adjust Potentiometer. Clockwise increases voltage 

(speed), counter-clockwise decreases voltage (speed).
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2.3.5 User Program Data Logging and Communications

Headers J1 and J4 are provided for user-programmed serial communications using the 

PICkit Serial Analyzer. The user may add code to the firmware to allow communica-

tions between the PICkit Serial Analyzer and the dsPIC33FJ32MC204 processor. The 

communications mode may be UART, SPI or I2C.

2.3.6 Re-Programming the dsPIC DSC PIM

The dsPIC33FJ32MC204 PIM included with the evaluation kit may be re-programmed 

with the user�s desired firmware. The PIM may be programmed on the evaluation 

board by using an external power source and either a PICkit 3 programmer, MPLAB 

REAL ICE in-circuit emulator or MPLAB ICD 3.

1. Connect the power source to the board as explained in Section 2.3.1.2.

2. Connect a PICkit 3 to the J2 header or connect either an MPLAB ICD 3 or 

MPLAB REAL ICE in-circuit emulator to the J3 (RJ12) jack.

3. Open up the MPLAB X Integrated Development Environment (IDE) and load the 

MCP8024 TQFP BLDC Motor Driver Evaluation Board firmware project. 

4. Build the project.

5. Program the device.

6. Press the RESET switch on the board to reset the processor and allow the 

processor to execute the new firmware program.

2.3.7 Configuring the MCP8024

The MCP8024 has configuration registers that may be used to modify operating param-

eters of the device. The parameters are modified by sending commands to the 

MCP8024 using the DE2 communication bus. The DE2 communication bus is a 

half-duplex, 9600 baud, 8-data bits, 1-stop bit, 1-start bit, no parity, serial communica-

tion link. The user may add code to the evaluation board firmware to communicate with 

the registers. The evaluation board software contains a subroutine which initializes the 

MCP8024 registers.

There are three configuration registers that may be written to. The registers are written 

to by sending a SET_CFG_x command byte followed by the desired register value byte. 

The configuration commands are listed in Table 2-6.

Note: Note that the following project options may need to be changed for the 

computer being used to build the firmware:

� Add Library libdsp-elf.a located in XC16 ???\src\Libdsp\lib 

directory.

� Add XC16-as ASM Include Directory in XC16 ???\src\Libdsp\asm.

� Set Hardware tool to �ICD 3�, �MPLAB REAL ICE� or �PICkit3�.
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TABLE 2-6: CONFIGURATION REGISTERS

Command Byte Bit Value Description

SET_CFG_0 1 � 81H Set Configuration Register 0

2 7 0 Reserved

6 0 Disable disconnect of 30K level translator pull up when CE = 0 (default)

1 Enable disconnect of 30K level translator pull up when CE = 0

5 0 Reserved

4 0 Reserved

3 0 Enable driver undervoltage lockout (default)

1 Disable driver undervoltage lockout

2 0 Enable external MOSFET short circuit detection (default)

1 Disable external MOSFET short circuit detection

1-0 00 Set external MOSFET overcurrent limit to 0.250V (default)

01 Set external MOSFET overcurrent limit to 0.500V

10 Set external MOSFET overcurrent limit to 0.750V

11 Set external MOSFET overcurrent limit to 1.000V

SET_CFG_1 1 � 83H Set Configuration Register 1

2 7-0 00H � FFH Select DAC current reference value

(4.503V - 0.991V)/255 = 13.77 mV/bit

00H = 0.991V

40H = 1.872V = 40H * 13.77 mV/Bit + 0.991V (default)

FFH = 4.503V = FFH * 13.77 mV/Bit + 0.991V

SET_CFG_2 1 � 87H Set Configuration Register 2

2 7-4 0000 Reserved

3-2 � Driver PWM dead time

00 2 µs (default)

01 1 µs 

10 500 ns 

11 250 ns 

1-0 � Driver Blanking Time (for Ignoring commutation spikes)

00 4 µs (default)

01 2 µs

10 1 µs

11 500 ns
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2.3.8 MCP8024 Status

The host may also solicit MCP8024 status information by issuing a STATUS_0 or 

STATUS_1 command. The MCP8024 may send an unsolicited STATUS_0 or 

STATUS_1 command to the host in the event of a fault or warning. The status 

registers are listed in Table 2-7.

TABLE 2-7: STATUS REGISTERS

Command Byte Bit Value Description

STATUS_0 1 � 85H Get Status Register 0 Command from Host to MCP8024

STATUS_1 1 � 86H Get Status Register 1 Command from Host to MCP8024

STATUS_0 1 � 45H Status Register 0 Response to Host from MCP8024

85H Status Register 0 Command to Host from MCP8024 (unsolicited)

2 7-0 00000000 Normal Operation

00000001 Temperature Warning (TJ > +125°C (Default Warning Level))

00000010 Over Temperature (TJ > +160°C)

00000100 Input Undervoltage (VDD < 5.5V)

00001000 Reserved

00010000 Input Overvoltage (VDD > 32V)

00100000 Buck Regulator Overcurrent

01000000 Buck Regulator Output Undervoltage Warning

10000000 Buck Regulator Output Undervoltage (< 80%, brown-out error)

STATUS_1 1 � 46H Status Register 1 Response to Host from MCP8024

86H Status Register 1 Command to Host from MCP8024 (unsolicited)

2 7-0 00000000 Normal Operation

00000001 5V LDO Overcurrent

00000010 12V LDO Overcurrent

00000100 External MOSFET Undervoltage Lockout (UVLO)

00001000 External MOSFET Overcurrent Detection

00010000 Brown-out Reset � Config Lost (Start-up default = 1)

00100000 Reserved

01000000 Reserved

10000000 Reserved
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NOTES:
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Appendix A. Schematic and Layouts

A.1 INTRODUCTION

This appendix contains the following schematics and layouts for the MCP8024 TQFP 

BLDC Motor Driver Evaluation Board:

� Board � Schematic

� Board � Top Silk Layer

� Board � Top Metal Layer

� Board � Mid1 Metal Layer

� Board � Mid2 Metal Layer

� Board � Bottom Metal Layer



M
C

P
8

0
2

4
 T

Q
F

P
 B

L
D

C
 M

o
to

r D
riv

e
r E

v
a

lu
a

tio
n

 B
o

a
rd

 U
s
e

r�s
 G

u
id

e

D
S

5
0

0
0

2
2

3
3

A
-p

a
g

e
 2

4


 2
0

1
3

 M
ic

ro
c
h

ip
 T

e
c
h

n
o

lo
g

y
 In

c
.

A.2 BOARD � SCHEMATIC

SPI

R
X

0.992V

PGND

NEUT

PH_C

PH_A

V
D

D

G
N

D

C
L

K

A
U

X

PAD6

DGND

R
C

3

R
C

5

PGND

PGND

PH_B

G
N

D

SDO

GND

ICSP CLK

VDD

GND

SPI_SDO

I2C_CLK, SPI_CLK I2C

T
X

+
V

Av=11

3.3V

Q3G

Q1G

Isense B Isense C

AGND

PGND

VDD

VDD

HALL +

HALL C

HALL A

MOTOR

SDI

SCK

/CS

+V

ICSP DAT

/MCLR

JP5

I2C_SDA, SPI_SDI

SPI

SPI_/SS

/M
C

L
R

MON3

MON2

MON1

D
A

T
A

2 4

1 3

SW2

SW2

1uF

10V

C38

47K
R67

1uF
10V

C17

DGND

2 4

1 3

SW3

RESET

1uF

10V

C40

PAD1
J1-4

PAD2
J1-5

AGND

4
7
K

R
3

2

PAD30

DGND

DGND

PGND

1K
R59

1K
R52

1K
R43

47K
R28

3.74K
R34

47K
R23

3.74K
R60

PGND

1526 Hz Filter

0.022uF

25V

C31

PGND

3.74K

R47

PAD33

PAD41

AGND

DGND

1K
R85

10.7K
R86

PGND

24.9K
R66

47K
R51

7.5K
R89

0.1uF
10V

C36

1K
R63

1K
R46

4.99
R3

1800 pF
50V

C4

TP4

PGND

TP5

10

R21

10

R11

10

R13

SS24-TP

D5

DGND

3.3 uH
744-042-003

L1

PAD4

Q2G

DGND

2.4K
R35

1

R1

100pF

25V

C34

2.4K
R37

100pF

25V

C35

47K

R58

4.7K
R49

4.7K
R50

PAD22

PAD16

PAD20

PGND

PGND

PAD9

TP2

VDD

1
1

2
2

J5

PAD5

TP1

HALL B

HALL -

0.1uF
10V

C41

DGND DGND

100
R70

1
3

2
10K
R75

100
R88

0.1uF
10V

C42

1uF
10V

C21

100pF
C22

GREEN

D14

PWM3H

47K
R40

47K

R7

GREEN

D19

PWM1L

PGND

0.022uF
25V

C29

AGND

100pF
C30

10 uF
50V

C12

10

R9

10

R16

10

R26

.01

5W

R54

F
D

D
1
0
A

N
0
6
A

0

Q1

F
D

D
1
0
A

N
0
6
A

0

Q6

11K
RFB2

R4

5V Transzorb
D1

0.047uF
25V

C24

90.9K
R71

.01

5W

R53

F
D

D
1
0
A

N
0
6
A

0

Q3

F
D

D
1
0
A

N
0
6
A

0

Q4

22K
R19

0.047uF
25V

C25

47K

R57

90.9K
R72

1 uF
50V

C11

22K
R17

AGND

1526 Hz Filter

HVIN2

JP10
DE2 To RC4

0.992V

152.6 Hz Filter

PGND

Isense A

Q5G

Vbuck = 1.25 (RFB1 + RFB2)/RFB2

VDD Max = 32V

30K
R74

2 4

1 3

SW1

SW1

47K
R14

1 2

3 4

JP6

S
E

R
_
T

X
_
S

E
L

JP1

DGND

1uF

10V

C39

3.74K
R41

HVIN1

LVOUT1

Av=11

1K
R33

LVOUT2

47K
R64 3.74K

R61

47K
R62

Av=11

47K

R44

3.74K
R45

SS24-TP

D4

100pF

25V

C33

TP6

4.7K
R48

300
R27

2.4K
R36

F
D

D
1
0
A

N
0
6
A

0

Q5

300

R22

Q6G

22K
R18

Q4G

F
D

D
1
0
A

N
0
6
A

0

Q2

SS24-TP

D6

1

JP15

PAD23

3

4

2

1

J6

DGND

2K
R87

52 61 43

J2
PICKit Prog

5

2

6

1

4

3

J4

PICKit Serial (SPI,I2C)

6

3

4

1

2

5

J3

ICD3 Debugger

100pF
C28

0.022uF

25V

C23

52 61 43

J1
PICKit Serial (UART)

0.1uF
10V

C43

GREEN

D15

PWM3L

MCP6021

V
IN

+
3

V
s
s

2

V
O

U
T

1
V

D
D

5

V
IN

-
4

U3

SS24-TP

D2

0.047uF
25V

C26

47K

R56

90.9K
R73

.01

5W

R55

22K
R20

300

R25

470 uF

50V

C10

5

2

1

3

4

J7

1

6

2

34

5

JP12

M
O

N
1
_
S

E
L

DSPIC_PIM_LNK

P
G

E
D

3
2
7

A
V

D
D

3
0

N
C

9
6

N
C

3
3

V
S

S
3
6

N
C

9
0

N
C

3
9

N
C

8
7

A
N

4
4
2

R
B

4
8

4

R
A

4
8

1

N
C

4
8

P
W

M
1
H

2
9

9

P
W

M
1

L
1

9
3

A
N

6
_

(J
u

m
p
e

r)
4
5

R
P

2
3
_

R
B

7
7

8

NC
52

NC
55

NC
58

NC
61

OSCO/CN29/RA3
64

NC
67

RP7
70

NC
73

P
G

E
C

3
2
6

N
C

2
9

N
C

2
8

A
V

S
S

3
1

N
C

9
5

A
N

2
3
5

N
C

3
8

A
N

3
4
1

N
C

3
4

V
D

D
3
7

N
C

4
0

A
N

5
4
3

N
C

9
1

N
C

8
8

N
C

8
6

N
C

8
9

N
C

9
2

R
A

8
8

3

V
C

A
P

8
5

N
C

4
7

N
C

5
0

N
C

4
9

N
C

4
6

NC
51

NC
54

NC
56

NC
57

NC
59

NC
60

NC
62

OSCI/CN30/RA2
63

NC
66

SCL1_RP24
68

SDA1_RP25
69

RA7
71

RP20_CN25_RC4
72

NC
74

NC
75

N
C

7
9

N
C

8
0

P
W

M
1

L
3

1
0

0

P
W

M
1

L
2

9
8

R
A

1
0

_
(J

u
m

p
e

r)
9

7

NC
53

VSS
65

R
P

2
2
_

R
C

6
7

7

R
P

2
1
_

R
C

5
7

6

AN1
24

NC
21

CN22_RB8
18

VSS
15

NC
12

NC
9

NC
6

PWM1H3
3

AN0
25

NC
22

RP9
19

NC
17

VDD
16

NC
14

/MCLR
13

AN7
20

NC
10

NC
8

NC
7

NC
4

NC
5

NC
1

NC
2

R
A

9
8

2

A
N

8
_

R
P

1
8
_

R
C

2
3
2

NC
23

P
W

M
1
H

1
9

4

NC
11

R
P

1
9

_
C

N
2

8
_

R
C

3
4
4

M1

DSPIC33FJ32MC204_PIM

IS
E

N
S

E
2

-
1

3
P

W
M

2
H

4
8

IL
IM

IT
1

5

IO
U

T
1

1
6

P
W

M
3

H
4
6

P
W

M
3
L

4
5

IS
E

N
S

E
+

1
8

P
G

N
D

1
9

C
A

P
1

4
3

C
A

P
2

4
2

L
A

2
1

L
B

2
2

F
B

4
0

V
D

D
3
9

P
G

N
D

2
4

L
X

3
7

PGND
7

LV_OUT1
8

HV_IN2
5

LV_OUT2
4

PWM1H
2

PWM1L
1

HB
26

HA
27

PHB
29

PHA
30

VBB
32

VBA
33

PGND
35

PGND
36

IOUT2
12

IOUT3
9

CE
3

HV_IN1
6

IS
E

N
S

E
2

+
1

4

IS
E

N
S

E
1

-
1

7

P
G

N
D

2
0

L
C

2
3

P
W

M
2
L

4
7

D
E

2
4
4

5
V

L
D

O
4
1

V
D

D
3
8

HC
25

PHC
28

VBC
31

12VLDO
34

ISENSE3+
11

ISENSE3-
10

U2

MCP8024

/MCLR_VPP

/MCLR_VPP

/M
C

L
R

_
V

P
P

+
3

.3
V

+3.3V

+3.3V

+
3

.3
V

+
3

.3
V

+3.3V

+
3

.3
V

+
3

.3
V

+3.3V

+3.3V

+3.3V

5
V

_
L

D
O

12V_LDO

12V_LDO

5V_LDO

5V_LDO

AVDD

AVDD

A
V

D
D

AVDD

AVDD
AVDD

DE2

DSPIC_RX

DSPIC_RX

DSPIC_RX

DSPIC_TX

DSPIC_TX

DSPIC_TX

HALL_A

HALL_A

HALL_B

HALL_B HALL_C

HALL_C

ILIMIT

ILIMIT

IOUTA

IOUTA

IOUTA

IO
U

T
B

IOUTB

IOUTB

IOUTC

IO
U

T
C

IOUTC

ISENSE_B

ISENSE_B

ISENSE_C

ISENSE_C

M
O

N
IT

O
R

_
1

M
O

N
IT

O
R

_
2

M
O

N
IT

O
R

_
3

M
O

N
IT

O
R

_
4

PGC

P
G

C

P
G

D

PGD

DGND

DGND

DGND

PGND

PGND

DGND

PGNDPGND

PGND

PGND

PHA_FIL

PHA_FIL

PHB_FIL

PHB_FIL PHC_FIL

PHC_FIL

P
O

T

P
O

T

PWM1H1

P
W

M
1
H

1

P
W

M
1
H

1

PWM1H2

P
W

M
1

H
2

P
W

M
1
H

2

PWM1H3

P
W

M
1

H
3

P
W

M
1
H

3

P
W

M
1
L

1

PWM1L1

P
W

M
1

L
1

PWM1L2

P
W

M
1

L
2

P
W

M
1

L
2

PWM1L3

P
W

M
1

L
3

P
W

M
1

L
3

RP22

R
P

2
2

R
P

2
3

RP23

RP24

RP24

RP25

RP25

SER_RX

S
E

R
_

R
X

SER_TX

S
E

R
_

T
X

S
P

A
R

E
_
L

E
D

S
P

A
R

E
_

L
E

D

SW1

S
W

1

SW2

S
W

2

VDD

V
D

D

VDD_DIV16

V
D

D
_

D
IV

1
6

VOFFSET

V
O

F
F

S
E

T

VOFFSET

VOFFSET

JP18

SMCJ30A

D3

1
8
 A

W
G

 W
ir
e

JP7

1
8
 A

W
G

 W
ir
e

JP8

DGND AGND

+3.3V

DGNDDGNDDGNDDGNDDGND

R
A

9

MCP8024 Buck

-
9

+
10

8V
D

D
4

A
G

N
D

1
1

U1:3

MCP6024

-
6

+
5

7U1:2MCP6024

-
2

+
3

1U1:1
MCP6024

MONITOR_1

MONITOR_2

MONITOR_3

-
13

+
12

14

U1:4
MCP6024

A
V

D
D

2.49K
R29

2.49K
R39

1-2 = I2C
2-3 = SPI

1

+
3

.3
V

1
JP9
CE

DGND

47K
R8

1 uF
50V

C19

PHA

PHB

PHC

2.49K
R15

2.49K
R65

1uF

10V

C1

1uF
10V

C2

1uF

10V

C3

47K
R5

+3.3V

AGND

1uF
10V

C18

47K
R68

47K
R69

1K
R84

1K
R83

1K
R82

1K
R81

1K
R80

1K
R79

GND

1

DE2

PAD10

PGND

5
V

_
L

D
O

5V LDO

PGND

10 uF

16V

C20

PAD15

V12

12V_LDO

Buck Feedback (FB)

Faraday Shield Ground Plane

18K
RFB1

R2

470 uF

50V

C9

0.047uF
25V

C27

300
R30

2.4K
R38

NEU_FIL

PAD17

PAD14

PAD34 PAD35

NEU_FIL PHC_FIL

PHA_FIL PHB_FIL

MONITOR_4

MON4NEU_FIL

1 uF
50V

C13
1 uF
50V

C14
1 uF
50V

C15

1
2

V
_

L
D

O

PGND

3.74K
R76

2K
R77

1K
R78

PAD19

IOUT1

IOUT2

1 uF
50V

C32

47K
R12

+
3

.3
V

1 2

3 4

JP11

S
E

R
_
R

X
_
S

E
L

1

6

2

34

5

JP13

M
O

N
2
_
S

E
L

1

6

2

34

5

JP14

M
O

N
3
_
S

E
L

+12V Hall Effect Supply

+5V Hall Effect Supply

2K
R6

2K
R10

10 uF

16V

C7

10 uF
16V

C6

10 uF
16V

C16

10 uF
16V

C5

10 uF
16V

C37

10 uF
16V

C8

3-4

1-2

JP11
3-4

JP8

1-2
JP9

JP6
1-2

1-2

2-3
JP3

1-2

JP1 ON

JP2

JP15
2-3

1-2

--------

2-3

JP4 ON

1-2

PositionJumper

2-3

5V Hall Sensor Power Supply

Routes DE2 to dsPIC RP20/CN25/RC4

CE Enabled

Enable dsPIC/Serial PICkit Comms

I2C Communications

SPI Communications

SPI Communications

Disable Buck Regulator

12V Hall Sensor Power Supply

Connect Phase Current To MONITOR1

Digital Ground Star Connection

CE Disabled

Enable dsPIC/DE2 Communication

Description

Enable Buck Regulator

JP12

JP5 Enable dsPIC/DE2 Communication

JP7 --------

Analog Ground Star Connection

JP10

3-4 Enable DE2/Serial PICkit Comms

ON

ON

Enable DE2/Serial PICkit Comms

Enable dsPIC/Serial PICkit Comms

2-3

1-2

Current Sense Offset = 0.0V

Current Sense Offset = 0.992V
JP16

JP13
JP14

Connect Filtered Phase To MONITOR2
Connect Hall Sensor To MONITOR35-6

PAD3

PAD39 PAD40
PAD38

Sums Phase CurrentsJP18 ----

JP17 ---- Selects Individual Phase Currents

TP3

JP3

GREEN

D16

PWM2H
GREEN

D17

PWM2L
GREEN

D18

PWM1H
GREEN

D13

+BUCK
GREEN

D12

+5V
GREEN

D11

+12V
GREEN

D10

Spare

2.49K
R24

2.49K
R31

2.49K
R42

PAD42

POT

SMAJ33CA
D22

SMAJ33CA
D20

SMAJ33CA
D21

JP17

JP16
DNP

1
JP2

RA3

RA2

JP4

ISENSE_BL

ISENSE_BL

ISENSE_CL

ISENSE_CL

1uF
10V

C44

AGND



Schematic and Layouts

 2013 Microchip Technology Inc. DS50002233A-page 25

A.3 BOARD � TOP SILK LAYER
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A.4 BOARD � TOP METAL LAYER
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A.5 BOARD � MID1 METAL LAYER
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A.6 BOARD � MID2 METAL LAYER
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A.7 BOARD � BOTTOM METAL LAYER
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Appendix B. Bill of Materials (BOM)

TABLE B-1: BILL OF MATERIALS (BOM)

Qty Designator Description Manufacturer Part Number

4 Bumpons BUMPON TALL TAPER SQ .50X.23 BK 3M SJ-5518(BLACK)

10 C1, C2, C3, C17, 

C18, C21, C38, 

C39, C40, C44

Cap Ceramic 1 µF 10V 10% X7R 0603 Taiyo Yuden Co., Ltd. LMK107B7105KA-T

1 C4 Cap Ceramic 1800 pF 50V 10% X7R 0805 AVX Corporation 08055C182KAT2A

7 C5, C6, C7, C8, 

C16, C20, C37

Cap Ceramic 10 µF 16V 10% X7R 1206 TDK Corporation C3216X7R1C106K160

AC

2 C9, C10 Cap Alum-Elect 470 µF 50V 20% Radial 

12.5 mm Dia, 5 mm lead spacing

United Chemi-Con EKZE500ELL471MK20

S

6 C11, C13, C14, 

C15, C19, C32

Cap Ceramic 1 µF 50V 10% X7R 1210 Taiyo Yuden Co., Ltd. UMK325B7105KH-T

1 C12 Cap Ceramic 10 µF 50V 10% X5R 1210 Taiyo Yuden Co., Ltd. UMK325BJ106KM-T

6 C22, C28, C30, 

C33, C34, C35

Cap Ceramic 100 pF 50V 10% X7R 0603 TDK Corporation C1608X7R1H101K 

Vishay 

Intertechnology, Inc.

VJ0603Y101KX-

ACW1BC

3 C23, C29, C31 Cap Ceramic 0.022 µF 25V 10% X7R 0603 TDK Corporation C1608X7R1E223K

4 C24, C25, C26, 

C27

Cap Ceramic 0.047µF 25V 10%  X7R 0603 Yageo Corporation CC0603KRX7R8BB473

4 C36, C41, C42, 

C43

Cap Ceramic 0.1 µF 25V 10% X7R 0603 Yageo Corporation CC0603KRX7R8BB104

1 D1 Transient Voltage Suppressor 400W 5% 

5V SMA

Vishay 

Intertechnology, Inc.

SMAJ5.0A-E3/61

4 D2, D4, D5, D6 Diode Schottky 40V 2A SMA Micro Commercial 

Components 

Corporation/Diodes® 

Incorporated

SS24-TP / B240A-13-F

1 D3 Transient Voltage Suppressor 1500W 30V 

SMC

Vishay 

Intertechnology, Inc.

SMCJ30A-E3/57T

10 D10, D11, D12, 

D13, D14, D15, 

D16, D17, D18, 

D19

Light Emitting Diode Green, 2 x 1.2 MM, 

570 NM, WTR CLR, SMD

Kingbright APT2012CGCK

3 D20, D21, D22 Transient Voltage Suppressor 400W 33V 

Bidirectional SMA

Vishay 

Intertechnology, Inc.

SMAJ33CA-E3/5A

3 J1, J2, J4 Header 1 x 6, 0.1 Centers Molex® 0022284360 (1 rows x 

36 columns, cut as 

needed)

1 J3 RJ12 6P6C Right Angle Jack TE Connectivity, Ltd. 5555165-1

1 J5 Terminal Block 2 pin, 2.54mm Phoenix Contact 

GmbH & Co.

Phoenix Contact 

1725656

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 

used in manufacturing uses all RoHS-compliant components.
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1 J6 Terminal Block 4 pin, 2.54mm Phoenix Contact 

GmbH & Co.

Phoenix Contact 

1725672

1 J7 Terminal Block 5 pin, 2.54mm Phoenix Contact 

GmbH & Co.

Phoenix Contact 

1725686

14 JP** CONN JUMPER SHORTING GOLD 

FLASH

Sullins Connector 

Solutions

SPC02SYAN

4 JP1, JP4, JP5, 

JP10

Header 1 x 2, 0.1 Centers Molex 0022284360 

(1 rows x 36 columns, 

cut as needed)

5 JP2, JP3, JP9, 

JP15, JP18

Header 1 x 3, 0.1 Centers Molex 0022284360 

(1 rows x 36 columns, 

cut as needed)

2 JP6, JP11 Header 2 x 2, 0.1 Centers Molex 0702800448 

(2 rows x 50 columns, 

cut as needed)

3 JP7, JP8, JP17 Wire 18 AWG, As needed � 18 AWG bare wire as 

needed

3 JP12, JP13, 

JP14

Header 2 x 3, 0.1 Centers Molex 0702800448 

(2 rows x 50 columns, 

cut as needed)

1 L1 Inductor 3.3 µH Wurth® Group 744-042-003

1 M1 dsPIC33F GP 44P QFN TO 100P PIM 

dsPIC33FJ32MC204 

Microchip 

Technology Inc.

MA330017

4 M1 Headers Fine Pitch Header, 1 row 25 columns Samtec, Inc. MTMS-125-01-G-S-230

6 Q1, Q2, Q3, Q4, 

Q5, Q6

MOSFET N-CH 60V 50A D-PAK Fairchild 

Semiconductor®
FDD10AN06A0

1 PCB Printed Circuit Board � MCP8024 TQFP 

BLDC Motor Driver Evaluation Board

Microchip 

Technology Inc.

104-10239

1 R1 RES 1.00 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-071RL

1 R2 RES 18.0 k 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-0718KL

1 R3 RES 4.99 1/8W 1% 0805 SMD Yageo Corporation RC0805FR-074R99L

1 R4 RES 11.0 k 1/10W 1% 0603 SMD Yageo Corporation/

Panasonic® - ECG

RC0603FR-0711KL/

ERJ-3EKF1102V

19 R5, R7, R8, R12, 

R14, R23, R28, 

R32, R40, R44, 

R51, R56, R57, 

R58, R62, R64, 

R67, R68, R69

RES 47.0 k 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-0747KL

3 R6, R10, R87 RES 2.00 k 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-072KL

6 R9, R11, R13, 

R16, R21, R26

RES 10.0 1/8W 1% 0805 SMD Yageo Corporation RC0805FR-0710RL

7 R15, R24, R29, 

R31, R39, R42, 

R65

RES 2.49 k 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-072K49L

4 R17, R18, R19, 

R20

RES 22.0 k 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-0722KL

4 R22, R25, R27, 

R30

RES 300 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-07300RL

TABLE B-1: BILL OF MATERIALS (BOM) (CONTINUED)

Qty Designator Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 

used in manufacturing uses all RoHS-compliant components.
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14 R33, R43, R46, 

R52, R59, R63, 

R78, R79, R80, 

R81, R82, R83, 

R84, R85

RES 1.00 k 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-071KL

7 R34, R41, R45, 

R47, R60, R61, 

R76

RES 3.74 k 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-073K74L

4 R35, R36, R37, 

R38

RES 2.40 k 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-072K4L

3 R48, R49, R50 RES 4.70 k 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-074K7L

3 R53, R54, R55 RES .010 5W 1% FLAT SMD TT Electronics 

Plc./IRC

OARSXPR010FLF

1 R66 RES 24.9 k 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-0724K9L

2 R70, R88 RES 100 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-07100RL

3 R71, R72, R73 RES 90.9 k 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-0790K9L

1 R74 RES 30.0 k 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-0730KL

1 R75 Potentiometer 10 k 1/8W CARB VERTI-

CAL

CTS® Corporation 296UD103B1N

1 R77 RES 2.00 k 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-072KL

1 R86 RES 10.7 k 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-0710K7L

1 R89 RES 7.50 k 1/10W 1% 0603 SMD Yageo Corporation RC0603FR-077K5L

3 SW1, SW2, 

SW3

SWITCH TACTILE SPST-NO 0.05A 12V E-Switch®, Inc. TL330INF260QG

6 TP1, TP2, TP3, 

TP4, TP5, TP6

SMT Test Point Keystone 

Electronics Corp.

5016

1 U1 MCP6024 Quad Op Amp � Plastic TSSOP, 

14-lead

Microchip 

Technology Inc.

MCP6024-E/ST

1 U2 3-Phase Brushless DC (BLDC) Motor Gate 

Driver with Power Module - Plastic Thin 

Quad Flatpack with Exposed Pad - 7x7 mm 

body, 48-lead, Thermally Enhanced (EP)

Microchip 

Technology Inc.

MCP8024-H/PT

1 U3 MCP6021 Single Op Amp - Plastic Small 

Outline Transistor (SOT-23), 5-lead

Microchip 

Technology Inc.

MCP6021T-E/OT

TABLE B-1: BILL OF MATERIALS (BOM) (CONTINUED)

Qty Designator Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 

used in manufacturing uses all RoHS-compliant components.
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Appendix C. Software

C.1 SELECTED SOFTWARE CONSTANTS AND DEFINITIONS

1. FOSC

Microprocessor Oscillator Frequency in Hz. based upon PLL scaling.

2. FPWM = 40000

Selects dsPIC DSC PWM period in Hz.

3. LOOPMODE = CLOSEDLOOPMODE

Sets motor controller to use closed loop control. The PID control functions will be 

used to control motor speed. 

4. LOOPMODE = OPENLOOPMODE

Sets motor controller to use open loop control. The speed adjust input relative 

position will be used to set the motor speed. 

5. PWM_MODE_SELECT = PWM_MODE_SELECT_INDEPENDENT

Sets the low-side external MOSFET driver to operate independently of the 

high-side driver.

6. PWM_MODE_SELECT = PWM_MODE_SELECT_COMPLEMENTARY

Sets the low-side external MOSFET driver to operate in complement of the 

high-side driver.

7. PWM_COUNTS_PER_PERIOD = (FCY/FPWM � 1)

Defines the number of timer counts per PWM period.

8. RAMP_UP_PERIODS

Defines the number of PWM periods to use to ramp the motor speed during 

startup.

9. MAX_DUTY_CYCLE

Defines the maximum desired PWM duty cycle.

10. MIN_DUTY_CYCLE

Defines the minimum desired PWM duty cycle.

11. MIN_SAMPLE_TIME

Defines the minimum allowable PWM duty cycle based upon A/D sample time.

12. STARTUP_DUTY_CYCLE

Defines the minimum desired PWM duty cycle during motor startup.

13. PHASE_ADVANCE_DEGREES

Defines the number of electrical degrees (in timer tics) that will be subtracted 

from the calculated commutation timer reload count. This allows for compensat-

ing for any latencies in the system.

14. ZC_BLANKING_COUNT

Defines the number of PWM periods that the ADC readings are ignored. This 

allows filtering of signals after commutation when high voltage spikes may be 

present.

15. unsigned int ReferenceSpeed

Contains the motor target speed based upon the SPEED potentiometer input.
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16. int DesiredSpeed

Contains the desired motor target speed based upon the SPEED potentiometer 

input.

17. int CurrentSpeed

Contains the current motor speed.

18. unsigned int SpeedControl_P

Proportional term of the closed loop PID control function. Sets the motor gain 

coefficient for the current speed error.

19. unsigned int SpeedControl_I

Integral term of the closed loop PID control function. Sets the motor gain coeffi-

cient for previous speed changes.

20. unsigned int SpeedControl_D

Derivative term of the closed loop PID control function. Sets the motor gain coef-

ficient for predicted errors in the motor control loop.

21. PWM_STATE[]

Array containing the high-side and low-side gate driver output states for a given 

step of the six-step commutation algorithm.

22. BOOTSTRAP_CHARGE_STATE

High-side and low-side gate driver output states for charging the bootstrap 

capacitors prior to motor startup.

23. MOTOR_SHUTDOWN_STATE

High-side and low-side gate driver output states that may be used when shutting 

down the motor.

24. ADC_MASK[]

A/D Back EMF mask used for majority detection.

25. ADC_XOR[]

A/D Back EMF mask used for majority detection.

26. ADC_BEMF_FILTER[]

A/D Back EMF filter table used to determine next commutation time.

C.2 DSPIC33FJ32MC204 PIM PORT USAGE

Port Name Description

/* Port A */

PORTA.2 DEBUG_PORT1 General purpose debug port

PORTA.3 DEBUG_PORT2 General purpose debug port

PORTA.4 SPARE_LED Spare LED port

PORTA.7 MCP8024_CE 1 = Enables MCP8024 output 

0 = Disables MCP8024 output

PORTA.8 SW1 Spare push button input

/* Port B */

PORTB.4 SW2 �On/Off� switch input

PORTB.8 ILIMIT_OUT MCP8024 ILIMIT_OUT signal: 

1 = OK 

0 = Fault/Current Limit

/* Port C */

PORTC.5 DEBUG_PORT3 General purpose debug port
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C.3 MPLAB X IDE COMPILER STARTUP

1. Start the MPLAB
 
X IDE compiler (not supplied, available on Microchip web 

page).

2. From the toolbar, select File > Open Project.

3. Browse to the evaluation board source code path.

4. Select the existing project file named MCP8024_ADM00557_EVAL.

5. In the Projects window, right mouse-click on MCP8024_ADM00557_EVAL and 

select Properties. The page contains the project properties. Processor, Compiler, 

Hardware and Config settings may be changed here.

6. Right click on the MCP8024_ADM00557_EVAL again and select the �Make and 

Program Device� option. This will compile the firmware and download to the 

programming hardware.

7. The compiler results will be displayed in the Output window frame. Verify 

success.

C.4 MPLAB X IDE AND PICkit 3 PROGRAMMER EXERCISE

1. Start the MPLAB X (not supplied, available on Microchip web page).

2. From the toolbar, select File > Open Project.

3. Browse to the evaluation board source code path.

4. Select the existing workspace directory named MCP8024_ADM00557_EVAL or 

create a new one.

5. Connect the PICkit 3 programmer to header J2 on the evaluation board. Align 

Pin 1 of the header with the Pin 1 mark on the programmer.

6. Set the bench power supply voltage control to the minimum voltage output.

7. Turn on the power supply and set the output voltage to 14V. Turn off the power 

supply.

8. Connect the bench power supply to the evaluation board. Connect +V(14V) to 

J5-2 and �V (Ground) to J5-1.

9. Turn on the power supply.

10. Right click on MCP8024_ADM00557_EVAL in the Projects window and select the 

�Make and Program Device� option. This will compile the firmware and program 

the dsPIC33FJ32MC204 PIM module.

11. The compiler results will be displayed in the Output window frame. Verify 

success.

12. Connect a brushless DC (BLDC) motor to connector J6. Connect the motor 

phase wires to the PH_A(J6-4), PH_B (J6-3) and PH_C (J6-2) terminals. The 

NEUT terminal (J6-1) is not used with the demonstration firmware.

13. Momentarily press the RESET switch on the evaluation board. This step is 

required to reset the dsPIC DSC device after programming.

14. Turn the SPEED adjustment fully counter-clockwise. This sets the motor to the 

slowest speed.

15. Momentarily press the SW2 switch to start the motor.

16. Momentarily press the SW2 switch again to stop the motor.

17. Momentarily press the SW2 switch again to start the motor.

18. Turn the SPEED adjustment clockwise. The motor speed should increase.

Note: The user may need to modify the paths to the source files and linker files 

based upon their locations on the host computer. Make sure to verify that 

the Libraries contains the correct path to libdsp-elf.a.

http://www.microchip.com/stellent/idcplg?IdcService=SS_GET_PAGE&nodeId=1406&dDocName=en019469&part=SW007002
http://www.microchip.com/stellent/idcplg?IdcService=SS_GET_PAGE&nodeId=1406&dDocName=en019469&part=SW007002
http://www.microchip.com/stellent/idcplg?IdcService=SS_GET_PAGE&nodeId=1406&dDocName=en019469&part=SW007002
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19. You may probe the different test points on the board to see the various signals 

being generated. The Q1G through Q6G test points will show the external MOS-

FET gate drive signals. The D14 through D19 LED�s show the state of the PWM 

inputs to the MCP8024. The MON1 through MON4 test points show the output 

of the jumper-selected signals. PHA_FIL, PHB_FIL and PHC_FIL are the filtered 

back EMF voltages from the motor. They are used to determine the commutation 

time in the demonstration firmware.

20. Stop the motor by pressing SW2 again.

21. Change the motor control from Closed Loop to Open Loop. This is done by 

editing the MCP8024_ADM00557_EVAL.C file.

22. Click on Source Files in the Projects window and then double click on the 

MCP8024_ADM00557_EVAL.C entry.

23. Search for the pre-processor definition LOOPMODE.

24. Change the LOOPMODE definition from CLOSEDLOOPMODE to 

OPENLOOPMODE.

25. Right click on MCP8024_ADM00557_EVAL in the Projects window and select 

�Make and Program Device�. This will compile the firmware and program the 

dsPIC33FJ32MC204 PIM module.

26. The compiler results will be displayed in the Output window frame. Verify 

success.

27. Momentarily press the RESET switch on the evaluation board. This step is 

required to reset the dsPIC DSC device after programming.

28. Turn the SPEED adjustment fully counter-clockwise. This sets the motor to the 

slowest speed.

29. Momentarily press the SW2 switch again to start the motor.

30. Turn the SPEED adjustment clockwise. The motor speed should increase.

31. In OPENLOOPMODE, the motor speed is forced based upon the position of the 

SPEED adjust potentiometer. If the SPEED adjust is set to 60%, the firmware will 

set the PWM duty cycle to 60%. While this allows for simple control of the motor, 

it is not efficient. If the motor is externally loaded, the motor may not be able to 

maintain the manually set commutation time which will result in a motor stall. The 

motor runs more efficiently when the motor is allowed to commutate based upon 

rotor location and not by an external reference. In CLOSEDLOOPMODE, the 

motor will commutate at the proper time based upon the Back EMF information. 

If the motor is externally loaded, the motor will automatically adjust for the load 

in order to maintain the correct commutation time.

32. Momentarily press the SW2 switch again to stop the motor.
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Tel: 317-773-8323

Fax: 317-773-5453

Los Angeles

Mission Viejo, CA 

Tel: 949-462-9523 

Fax: 949-462-9608

New York, NY 
Tel: 631-435-6000

San Jose, CA 
Tel: 408-735-9110

Canada - Toronto
Tel: 905-673-0699 

Fax: 905-673-6509

ASIA/PACIFIC

Asia Pacific Office

Suites 3707-14, 37th Floor

Tower 6, The Gateway

Harbour City, Kowloon

Hong Kong

Tel: 852-2401-1200

Fax: 852-2401-3431

Australia - Sydney
Tel: 61-2-9868-6733

Fax: 61-2-9868-6755

China - Beijing
Tel: 86-10-8569-7000 

Fax: 86-10-8528-2104

China - Chengdu

Tel: 86-28-8665-5511

Fax: 86-28-8665-7889

China - Chongqing

Tel: 86-23-8980-9588

Fax: 86-23-8980-9500

China - Hangzhou

Tel: 86-571-2819-3187 

Fax: 86-571-2819-3189

China - Hong Kong SAR

Tel: 852-2943-5100 

Fax: 852-2401-3431

China - Nanjing

Tel: 86-25-8473-2460

Fax: 86-25-8473-2470

China - Qingdao

Tel: 86-532-8502-7355

Fax: 86-532-8502-7205

China - Shanghai
Tel: 86-21-5407-5533 

Fax: 86-21-5407-5066

China - Shenyang

Tel: 86-24-2334-2829

Fax: 86-24-2334-2393

China - Shenzhen

Tel: 86-755-8864-2200 

Fax: 86-755-8203-1760

China - Wuhan

Tel: 86-27-5980-5300

Fax: 86-27-5980-5118

China - Xian

Tel: 86-29-8833-7252

Fax: 86-29-8833-7256

China - Xiamen

Tel: 86-592-2388138 

Fax: 86-592-2388130

China - Zhuhai

Tel: 86-756-3210040 

Fax: 86-756-3210049

ASIA/PACIFIC

India - Bangalore
Tel: 91-80-3090-4444 

Fax: 91-80-3090-4123

India - New Delhi

Tel: 91-11-4160-8631

Fax: 91-11-4160-8632

India - Pune

Tel: 91-20-3019-1500

Japan - Osaka

Tel: 81-6-6152-7160 

Fax: 81-6-6152-9310

Japan - Tokyo

Tel: 81-3-6880- 3770 

Fax: 81-3-6880-3771

Korea - Daegu
Tel: 82-53-744-4301

Fax: 82-53-744-4302

Korea - Seoul
Tel: 82-2-554-7200

Fax: 82-2-558-5932 or 

82-2-558-5934

Malaysia - Kuala Lumpur

Tel: 60-3-6201-9857

Fax: 60-3-6201-9859

Malaysia - Penang

Tel: 60-4-227-8870

Fax: 60-4-227-4068

Philippines - Manila

Tel: 63-2-634-9065

Fax: 63-2-634-9069

Singapore
Tel: 65-6334-8870

Fax: 65-6334-8850

Taiwan - Hsin Chu

Tel: 886-3-5778-366

Fax: 886-3-5770-955

Taiwan - Kaohsiung
Tel: 886-7-213-7830

Taiwan - Taipei
Tel: 886-2-2508-8600 

Fax: 886-2-2508-0102

Thailand - Bangkok

Tel: 66-2-694-1351

Fax: 66-2-694-1350

EUROPE

Austria - Wels

Tel: 43-7242-2244-39

Fax: 43-7242-2244-393

Denmark - Copenhagen
Tel: 45-4450-2828 

Fax: 45-4485-2829

France - Paris
Tel: 33-1-69-53-63-20 

Fax: 33-1-69-30-90-79

Germany - Dusseldorf
Tel: 49-2129-3766400

Germany - Munich

Tel: 49-89-627-144-0 

Fax: 49-89-627-144-44

Germany - Pforzheim
Tel: 49-7231-424750

Italy - Milan 
Tel: 39-0331-742611 

Fax: 39-0331-466781

Italy - Venice
Tel: 39-049-7625286 

Netherlands - Drunen

Tel: 31-416-690399 

Fax: 31-416-690340

Poland - Warsaw

Tel: 48-22-3325737 

Spain - Madrid
Tel: 34-91-708-08-90

Fax: 34-91-708-08-91

Sweden - Stockholm

Tel: 46-8-5090-4654

UK - Wokingham

Tel: 44-118-921-5800

Fax: 44-118-921-5820

Worldwide Sales and Service
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